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CHAPTER 12

Building formulas

forMulaS are the heart and soul of a spreadsheet, and Microsoft Excel offers a rich 
environment in which to build complex formulas. Armed with a few mathematical 
operators and rules for cell entry, you can turn a worksheet into a powerful calculator. 

In this chapter, we cover the basics and then look more closely at using functions, defining 
names, building structured references, working with arrays, creating linking formulas, and 
constructing conditional tests.

Formula fundamentals
A lot of this section will seem elementary to experienced Excel users, but it is important 
information for anyone who is just arriving at the party. And even experienced users might 
find something useful here that they didn’t know about.

All formulas in Excel begin with an equal sign.

This is the most fundamental fact of all. The equal sign tells Excel that the succeeding char-
acters constitute a formula. If you omit the equal sign, Excel might interpret the entry as 
text. To show how formulas work, we’ll walk you through some rudimentary ones. Begin by 
selecting blank cell A10. Then type =10+5, and press the Enter key. The value 15 appears 
in cell A10. Now select cell A10, and the formula bar displays the formula you just typed. 
What appears in the cell is the displayed value; what appears in the formula bar is the 
underlying value, which in this case is a formula.

Understanding the precedence of operators
Operators are symbols that represent specific mathematical operations, including the plus 
sign (+), minus sign (–), division sign (/), and multiplication sign (*). When performing these 
operations in a formula, Excel follows certain rules of precedence:

 ● Excel processes expressions within parentheses first.
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 ● Excel performs multiplication and division before addition and subtraction.

 ● Excel calculates consecutive operators with the same level of precedence from left to 
right.

Type some formulas to see how these rules apply. Select an empty cell, and type =4+12/6. 
Press Enter, and you see the value 6. Excel first divides 12 by 6 and then adds the result 
(2) to 4. Then select another empty cell, and type =(4+12)/6. Press Enter, and you see the 
value 2.666667. This demonstrates how you can change the order of precedence by using 
parentheses. The formulas in Table 12-1 contain the same values and operators, but note 
the different results caused by the placement of parentheses.

TABLE 12-1 Placement of parentheses

Formula Result

=3*6+12/4–2 19
=(3*6)+12/(4–2) 24
=3*(6+12)/4–2 11.5
=(3*6+12)/4–2 5.5
=3*(6+12/(4–2)) 36

If you do not include a closing parenthesis for each opening parenthesis in a formula, Excel 
displays the message “Microsoft Excel found an error in this formula” and provides a sug-
gested solution. If the suggestion matches what you had in mind, simply press Enter, and 
Excel completes the formula for you.

When you type a closing parenthesis, Excel briefly displays the pair of parentheses in bold. 
This feature is handy when you are typing a long formula and are not sure which pairs of 
parentheses go together.

Note
If you are unsure of the order in which Excel will process a sequence of operators, use 
parentheses even if the parentheses aren’t necessary . Parentheses also make your for-
mulas easier to read and interpret, which is helpful if you or someone else needs to 
change them later .
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Using cell references in formulas
A cell reference identifies a cell or group of cells in a workbook. When you include cell ref-
erences in a formula, the formula is said to be linked to the referenced cells. The resulting 
value of the formula depends on the values in the referenced cells and changes automati-
cally when the values in the referenced cells change.

To see cell referencing at work, select cell A1, and type the formula =10*2. Now select cell 
A2, and type the formula =A1. The value in both cells is 20. If at any time you change the 
value in cell A1, the value in cell A2 changes also. Now select cell A3, and type =A1+A2. 
Excel returns the value 40. Cell references are especially helpful when you create complex 
formulas.

Entering cell references by clicking

When you start a formula by typing an equal sign into a cell, you activate Enter mode. If 
you then click another cell, you don’t select it; instead, the cell’s reference is inserted in 
the formula. You can save time and increase accuracy when you enter cell references this 
way. For example, to enter references to cells A9 and A10 in a formula in cell B10, do the 
following:

1. Select cell B10, and type an equal sign.

2. Click cell A9, and type a plus sign.

3. Click cell A10, and press Enter.

When you click each cell, a marquee surrounds the cell, and Excel inserts a reference to 
the cell in cell B10. After you finish entering a formula, be sure to press Enter. If you do not 
press Enter but select another cell, Excel assumes you want to include that cell reference in 
the formula as well.

The active cell does not have to be visible in the current window for you to enter a value 
in that cell. You can scroll through the worksheet without changing the active cell and click 
cells in remote areas of your worksheet, in other worksheets, or in other workbooks as you 
build a formula. The formula bar displays the contents of the active cell no matter which 
area of the worksheet is currently visible.

Note
If you scroll through your worksheet and the active cell is no longer visible, you can 
display it by pressing Ctrl+Backspace . You can return to the upper-left corner of the 
worksheet by pressing Ctrl+Home .
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Understanding relative, absolute, and mixed references

Relative references—the type we’ve used so far in the sample formulas—refer to cells by 
their position in relation to the cell that contains the formula, such as “the cell two rows 
above this cell.” A relative reference to cell A1, for example, looks like this: =A1.

Absolute references refer to cells by their fixed position in the worksheet, such as “the cell 
located at the intersection of column A and row 2.” An absolute reference to cell A1 looks 
like this: =$A$1.

Mixed references contain a relative reference and an absolute reference, such as “the cell 
located in column A and two rows above this cell.” A mixed reference to cell A1 looks like 
this: =$A1 or =A$1.

Dollar signs in a cell reference indicate its absoluteness. If the dollar sign precedes only the 
letter (A, for example), the column coordinate is absolute and the row is relative. If the dol-
lar sign precedes only the number (1, for example), the column coordinate is relative and 
the row is absolute.

Absolute and mixed references are important when you begin copying formulas from one 
location to another in your worksheet. When you copy and paste, relative references adjust 
automatically, but absolute references do not. For information about copying cell refer-
ences, see “How copying affects cell references” later in this chapter.

While you are entering or editing a formula, press F4 to change reference types quickly. The 
following steps show how:

1. Select cell A1, and type =B1+B2 (but do not press Enter).

2. Press F4 to change the reference nearest the flashing pointer to absolute. The 
formula becomes =B1+$B$2.

3. Press F4 again to change the reference to mixed (relative column coordinate and 
absolute row coordinate). The formula becomes =B1+B$2.

4. Press F4 again to reverse the mixed reference (absolute column coordinate and 
relative row coordinate). The formula becomes =B1+$B2.

5. Press F4 again to return to the original relative reference.

When you use this technique to change reference types, click the formula bar to activate 
it. Then, before pressing F4, click in the cell reference you want to change or drag to select 
one or more cell references in the formula to change all the selected references at the same 
time.
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Creating references to other worksheets in the same workbook

You can refer to cells in other worksheets within the same workbook just as easily as you 
refer to cells in the same worksheet. For example, to enter a reference to cell A9 in Sheet2 
into cell B10 in Sheet1, do this:

1. Select cell B10 in Sheet1, and type an equal sign.

2. Click the Sheet2 tab.

3. Click cell A9, and then press Enter.

After you press Enter, Sheet1 once again becomes the active sheet. Select cell B10, and you 
can see that it contains the formula =Sheet2!A9.

The worksheet portion of the reference is separated from the cell portion by an exclama-
tion point. Note also that the cell reference is relative, which is the default when you select 
cells to create references to other worksheets.

Creating references to worksheets in other workbooks

You can refer to cells in worksheets in separate workbooks in the same way you refer to 
cells in other worksheets within the same workbook. These references are called external 
references. For example, to enter a reference to Book2 in Book1, follow these steps:

1. Create a new workbook—Book2—by clicking the File tab, clicking New, and double-
clicking Blank Workbook.

2. Click the View tab, click Arrange All, select the Vertical option, and click OK.

3. Select cell A1 in Sheet1 of Book1, and type an equal sign.

4. Click anywhere in the Book2 window to make the workbook active.

5. Click the Sheet2 tab at the bottom of the Book2 window.

6. Click cell A2. Before pressing Enter to lock in the formula, your screen should look 
similar to Figure 12-1. Note that when you click to enter references to cells in external 
workbooks, the inserted references are absolute.

7. Press Enter to lock in the reference.



Chapter 12

472 Chapter 12 Building formulas

Figure 12-1 Enter external references easily by clicking the cell to which you want to refer.

Understanding the row-column reference style
In the regular A1 reference style, rows are numbered and columns are designated by 
letters . In the R1C1 reference style, both rows and columns are numbered . The cell 
reference R1C1 means row 1, column 1; therefore, R1C1 and A1 refer to the same cell . 
Although the R1C1 reference style isn’t widely used anymore, it was the standard in 
some classic spreadsheet programs, such as Microsoft Multiplan .

To turn on the R1C1 reference style, click the File tab, click Options, select the Formulas 
category, select the R1C1 Reference Style check box, and then click OK . The column 
headers change from letters to numbers, and the cell references in all your formulas 
automatically change to R1C1 format . For example, cell M10 becomes R10C13, and cell 
XFD1048576, the last cell in your worksheet, becomes R1048576C16384 .

In R1C1 notation, a relative cell reference is displayed in terms of its relationship to the 
cell that contains the formula rather than by its actual coordinates . This can be helpful 
when you are more interested in the relative position of a cell than in its absolute posi-
tion . For example, suppose you want to enter in cell R10C2 (B10) a formula that adds 
cells R1C1 (A1) and R1C2 (B1) . After selecting cell R10C2, type an equal sign, select 
cell R1C1, type a plus sign, select cell R1C2, and then press Enter . When you select cell 
R10C2, the formula =R[–9]C[–1]+R[–9]C appears in the formula bar . Negative row and 
column numbers indicate that the referenced cell is above or to the left of the formula 
cell; positive numbers indicate that the referenced cell is below or to the right of the 
formula cell . The brackets indicate relative references . This formula reads, “Add the cell 
nine rows up and one column to the left to the cell nine rows up in the same column .”

A relative reference to another cell must include brackets . Otherwise, Excel assumes 
you’re using absolute references . For example, if you select the entire formula we cre-
ated in the previous paragraph in the formula bar and press F4, the formula changes to 
=R1C1+R1C2 using absolute references .
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How copying affects cell references

One of the handiest benefits of using references is the ability to copy and paste formulas. 
But you need to understand what happens to your references after you paste so that you 
can create formulas with references that operate the way you want them to operate.

Copying relative references When you copy a cell containing a formula with relative 
cell references, Excel changes the references automatically relative to the position of the 
cell where you paste the formula. Referring to Figure 12-2, suppose you type the formula 
=AVERAGE(B4:E4) in cell F4. This formula averages the values in columns B through E.

Figure 12-2 Cell F4 contains relative references to the cells to its left.

You’ll find the Exams.xlsx file with the other examples on the companion website.

You want to include this calculation for the remaining rows as well. Instead of typing a new 
formula in each cell in column F, select cell F4 and press Ctrl+C to copy it (or click the Copy 
button in the Clipboard group on the Home tab). Then select cells F5:F8, click the arrow 
next to the Paste button on the Home tab, click Paste Special, and then select the Formu-
las And Number Formats option (to preserve the cell and border formatting). Figure 12-3 
shows the results. Because the formula in cell F4 contains a relative reference, Excel adjusts 
the references in each copy of the formula. As a result, each copy of the formula calculates 
the average of the cells in the corresponding row. For example, cell F5 contains the formula 
=AVERAGE(B5:E5).
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Figure 12-3 We copied the relative references from cell F4 to cells F5:F8.

Copying absolute references If you want cell references to remain the same when you 
copy them, use absolute references. For example, in the worksheet on the left in Figure 
12-4, cell B2 contains the hourly rate at which employees are to be paid and cell C5 con-
tains the relative reference formula =B2*B5. Suppose you copy the formula in C5 to the 
range C6:C8. The worksheet on the right in Figure 12-4 shows what happens: you get 
erroneous results. The formulas in cells C6:C8 should refer to cell B2, but they don’t. For 
example, cell C8 contains the incorrect formula =B5*B8.

Figure 12-4 The formula in cell C5 contains relative references. We copied the relative formula 
in cell C5 to cells C6:C8, producing incorrect results.

You’ll find the Wages.xlsx file with the other examples on the companion website.

Because the reference to cell B2 in the original formula is relative, it changes as you 
copy the formula to the other cells. To correctly apply the wage rate in cell B2 to all the 
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calculations, you must change the reference to cell B2 to an absolute reference before you 
copy the formula.

To change the reference style, click the formula bar, click the reference to cell B2, and then 
press F4. The result is the following formula: =$B$2*B5.

When you copy this modified formula to cells C6:C8, Excel adjusts the second cell reference 
within each formula but not the first. In Figure 12-5, cell C8 now contains the correct for-
mula: =$B$2*B8.

Figure 12-5 We created an absolute reference to cell B2 before copying the formula.

Copying mixed references You can use mixed references in your formulas to anchor a 
portion of a cell reference. (In a mixed reference, one portion is absolute, and the other is 
relative.) When you copy a mixed reference, Excel anchors the absolute portion and adjusts 
the relative portion to reflect the location of the cell to which you copy the formula.

To create a mixed reference, you can press the F4 key to cycle through the four combina-
tions of absolute and relative references—for example, from B2 to $B$2 to B$2 to $B2.

The loan payment table in Figure 12-6 uses mixed references (and an absolute reference). 
You need to enter only one formula in cell C6 and then copy it down and across to fill the 
table. Cell C6 contains the formula = –PMT($B6,$C$3,C$5) to calculate annual payments 
on a loan. We copied this formula to all the cells in the range C6:F10 to calculate payments 
using three additional loan amounts and four additional interest rates.
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Figure 12-6 This loan payment table uses formulas that contain mixed references.

You’ll find the Loan.xlsx file with the other examples on the companion website.

The first cell reference, $B6, indicates that we always want to refer to the values in column 
B but the row reference (Rate) can change. Similarly, the mixed reference, C$5, indicates we 
always want to refer to the values in row 5 but the column reference (Loan Amount) can 
change. For example, cell E8 contains the formula = –PMT($B8,$C$3,E$5). Without mixed 
references, we would have to edit the formulas manually in each of the cells in the range 
C6:F10.

TROUBLESHOOTING
Inserted cells are not included in formulas
If you have a SUM formula at the bottom of a row of numbers and then insert new 
rows between the numbers and the formula, the range reference in the SUM function 
doesn’t include the new cells . Unfortunately, you can’t do much about this . This is an 
age-old worksheet problem, but Excel attempts to correct it for you automatically . 
Although the range reference in the SUM formula does not change when you insert 
the new rows, it adjusts as you type new values in the inserted cells . The only caveat is 
that you must enter the new values one at a time, starting with the cell directly below 
the column of numbers . If you enter values in the middle of a group of newly inserted 
rows or columns, the range reference remains unaffected . For more information about 
the SUM function, see “Using the SUM function” in Chapter 14, “Everyday functions .”
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Editing formulas
You edit formulas the same way you edit text entries: click in the cell or formula bar, click or 
drag to select characters, press Backspace or Delete or start typing. To replace a cell refer-
ence, highlight it and click the new cell you want the formula to use; Excel enters a relative 
reference automatically. You can also just click to place the insertion point where in the 
formula you want to insert a reference. To include cell B1 in the formula =A1+A3, place the 
insertion point between A1 and the plus sign, type another plus sign, and then click cell B1. 
Excel inserts the reference and the formula becomes =A1+B1+A3.

Understanding reference syntax

So far, we have used the default worksheet and workbook names for the examples in this 
book. When you save a workbook, you must give it a permanent name. If you create a for-
mula first and then save the workbook with a new name, Excel adjusts the formula accord-
ingly. For example, if you save Book2 as Sales.xlsx, Excel changes the remote reference 
formula =[Book2]Sheet2!$A$2 to =[Sales.xlsx]Sheet2!$A$2. And if you rename Sheet2 of 
Sales.xlsx to February, Excel changes the reference to =[Sales.xlsx]February!$A$2. If the ref-
erenced workbook is closed, Excel displays the full path to the folder where the workbook is 
stored in the reference, as shown in the example ='C:\Work\[Sales.xlsx]February'!$A$2.

In the preceding example, note that apostrophes surround the workbook and worksheet 
portion of the reference. Excel adds the apostrophes around the path when you close the 
workbook. If you type a new reference to a closed workbook, however, you must add the 
apostrophes yourself. To avoid typing errors, it is best to work with the linked workbooks 
open and click cells to enter references so that Excel inserts them in the correct syntax for 
you.

Using numeric text in formulas

The seemingly oxymoronic term numeric text refers to an entry that is not strictly numbers 
but includes both numbers and a few specific text characters. You can perform mathemati-
cal operations on numeric text values as long as the numeric string uses only the following 
characters in very specific ways:

0 1 2 3 4 5 6 7 8 9 . + – E e

In addition, you can use the forward slash (/) character in fractions. You can also use the fol-
lowing five number-formatting characters:

$ , % ( )
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You must enclose numeric text strings in quotation marks. For example, if you type the 
formula =$1234+$123, Excel displays an error message. (The error message also offers to 
correct the error for you by removing the dollar signs.) But the formula ="$1234"+"$123" 
produces the result 1357 (ignoring the dollar signs). When Excel performs the addition, it 
automatically translates numeric text entries into numeric values.

For more information about number-formatting characters, see “Formatting as you type” in 
Chapter 9, “Worksheet formatting techniques .”

About text values

The term text value refers to any entry that is neither a number nor a numeric text value (as 
explained in the previous section); Excel treats the entry as text only. You can refer to and 
manipulate text values by using formulas. For example, if cell A1 contains the text First and 
you type the formula =A1 in cell A10, cell A10 displays First.

For more information about manipulating text with formulas, see “Understanding text func-
tions” in Chapter 14 .

You can use the & (ampersand) operator to concatenate, or join, several text values. Extend-
ing the preceding example, if cell A2 contains the text Quarter and you type the formula 
=A1&A2 in cell A3, then cell A3 displays FirstQuarter. To include a space between the two 
strings, change the formula to =A1&" "&A2. This formula uses two concatenation operators 
and a literal string, or string constant (in this case, a space enclosed in quotation marks).

You can use the & operator to concatenate strings of numeric values as well. For example, 
if cell A3 contains the numeric value 867 and cell A4 contains the numeric value 5309, the 
formula =A3&A4 produces the string 8675309. This string is left-aligned in the cell because 
it’s considered a text value. (Remember, you can use numeric text values to perform any 
mathematical operation as long as the numeric string contains only the numeric characters 
listed in the previous section.)

Finally, you can use the & operator to concatenate a text value and a numeric value. For 
example, if cell A1 contains the text January and cell A3 contains the numeric value 2009, 
the formula =A1&A3 produces the string January2009.



Ch
ap

te
r 1

2

 Formula fundamentals 479

INSIDE OUT   Practical concatenation

Depending on the kind of work you do, the text manipulation prowess of Excel might 
turn out to be the most important skill you learn in this book . If you deal with a lot 
of mailing lists, for example, you probably use a word-processing application such as 
Microsoft Word. But you might find that Excel has the tools you’ve been wishing for, 
and it just might become your text-manipulation application of choice .

Suppose you have a database of names in which the first and last names are stored in 
separate columns . This example shows you how to generate lists of full names:

We created the full names listed in columns D and E using formulas like the one visible 
in the formula bar . For example, the formula in cell D2 is =B2&" "&A2, which concat-
enates and reverses the contents of the cells in columns A and B and adds a space char-
acter in between. The formula in cell E2 (=A2&", "&B2) reverses the position of the first 
and last names and adds a comma before the space character . For another nifty—and 
related—trick, see the sidebar “Practical text manipulation” in Chapter 14 . And for an 
even niftier related feature that is new in Excel 2013, see “Automatic parsing and con-
catenation using Flash Fill” in Chapter 8, “Worksheet editing techniques .”

You’ll find the Concatenation.xlsx file with the other examples on the companion website.
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Understanding error values
An error value is the result of a formula that Excel can’t resolve. Table 12-2 describes the 
seven error values.

TABLE 12-2 Error values

Error value Cause

#DIV/0! You attempted to divide a number by zero. This error usually occurs when 
you create a formula with a divisor that refers to a blank cell.

#NAME? You typed a name that doesn’t exist in a formula. You might have 
mistyped the name or typed a deleted name. Excel also displays this error 
value if you do not enclose a text string in quotation marks.

#VALUE You entered a mathematical formula that refers to a text entry.
#REF! You deleted a range of cells whose references are included in a formula.
#N/A No information is available for the calculation you want to perform. When 

building a model, you can type #N/A in a cell to show you are awaiting 
data. Any formulas that reference cells containing the #N/A value return 
#N/A.

#NUM! You provided an invalid argument to a worksheet function. #NUM! can 
indicate also that the result of a formula is too large or too small to be 
represented in the worksheet.

#NULL! You included a space between two ranges in a formula to indicate an 
intersection, but the ranges have no common cells.

Using functions: A preview
In simplest terms, a function is a predefined formula. Many Excel functions are  shorthand 
versions of frequently used formulas. For example, compare =A1+A2+A3+A4+A5+A6+A7 
+A8+A9+A10 with =SUM(A1:A10). The SUM function makes the formula shorter, easier to 
read, and easier to create. Most Excel functions perform much more complex calculations, 
like the PMT function, which lets you calculate a loan payment at a given interest rate and 
principal amount.

All functions consist of a function name followed by a set of arguments enclosed in paren-
theses. (In the preceding example, A1:A10 is the argument in the SUM function.) If you omit 
a closing parenthesis when you enter a function, Excel adds the parenthesis after you press 
Enter—as long as it’s obvious where the parenthesis is supposed to go. (Relying on this fea-
ture can produce unpredictable results; for accuracy, always verify your parentheses.)

For more information about functions, see Chapter 13, “Using functions .” For more about the 
SUM function, see Chapter 14 .
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Using the Sum button
No surprise—the SUM function is used more often than any other function. To make this 
function more accessible, Excel includes the Sum button (which may be labeled AutoSum, 
depending on your screen resolution and window size) on the Home tab on the ribbon, 
which inserts the SUM function into a cell. (The ScreenTip that appears when you rest the 
pointer over this button says Sum. On the Formulas tab, the button includes the label Auto-
Sum, which also appears on the Home tab if your screen is wide enough.)

Note
You can quickly enter a SUM function in the selected cell by pressing Alt+= .

To see how this works, do the following:

1. Enter a column of numbers, like we did in Figure 12-7.

Figure 12-7 Use the Sum button to add a summary formula in a cell adjacent to columns 
or rows of numbers.

2. Select the cell below the column of numbers, and click the Sum button in the Editing 
group on the Home tab. The button inserts the entire formula for you and suggests a 
range to sum.

3. Check the selection. If the suggested range is incorrect, simply drag through the 
correct range.

4. Press Enter.
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The Sum button includes a menu that appears when you click the arrow next to the button, 
as shown in Figure 12-7, offering popular alternative functions you can choose instead. The 
More Functions command opens the Insert Function dialog box, where you can access any 
Excel function. If you select a contiguous cell range that is adjacent to rows or columns of 
numbers before clicking the Sum button, Excel enters a SUM function in each cell.

Note
Get a quick sum by selecting the cells you want to sum and then looking at the status 
bar, where Excel automatically displays the sum, average, and count (the total number 
of cells containing entries) of the selected range . Right-click the status bar to add more 
readouts for the minimum, maximum, and numerical counts . For more information, see 
“Quick totals on the status bar” in Chapter 2, “Exploring Excel fundamentals .”

For more information, see “Using the SUM function” in Chapter 14 .

Inserting a function
When you want to use a built-in function, click the Insert Function button on the Formulas 
tab on the ribbon (or the little fx icon located on the formula bar). When you do, the Insert 
Function dialog box shown in Figure 12-8 appears. For all the details about using the Insert 
Function dialog box, see “Inserting functions” in Chapter 13.

Figure 12-8 The Insert Function dialog box gives you access to all the built-in functions in Excel.
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Using Formula AutoComplete
Excel makes creating formulas a little easier with a feature called Formula AutoComplete. 
Figure 12-9 illustrates what happens when you type an equal sign followed by the letter 
S—Excel lists all functions that begin with that letter. Formula AutoComplete also provides 
lists of defined names and function arguments, as well as special codes and names used in 
structured references and Cube functions. These lists appear automatically in the appropri-
ate places as you enter a formula.

For more about defined names, see “Using names in formulas” later in this chapter; for more 
about structured references, see “Using structured references” later in this chapter .

Figure 12-9 When you start to type a function, Excel lists all the functions that begin with the 
letter or letters you first type.

You can just keep typing your formula, or you can click any of the items in the Auto-
Complete list to see a pop-up description of what that function does. Scroll down the list to 
see more functions; to insert one of the functions into your formula, double-click it. As you 
type additional characters, the list narrows further. For example, typing =si in the example 
shown in Figure 12-9 would narrow the AutoComplete list to three functions: SIGN, SIN, 
and SINH. Formula AutoComplete also works within nested formulas. For example, if you 
start typing a formula such as =SUM(SIN(A4),S into a cell, the AutoComplete list appears 
and readjusts its contents for each letter you type in the formula.
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Working with formulas
We’ve covered most of the basics you need to know about how formulas and references 
work. In the following sections, we’ll dig deeper, covering how to use defined names, inter-
sections, structured references, and three-dimensional (3-D) formulas.

Naming cells and cell ranges
If you find yourself repeatedly typing cryptic cell addresses, such as Sheet3!A1:AJ51, into 
formulas, here’s a better approach. Assign a short, memorable name to any cell or range 
and then use that name instead of the cryptogram in formulas. Naming cells has no effect 
on either their displayed values or their underlying values—you are just assigning nick-
names you can use when creating formulas.

Each workbook contains its own set of names. After you define names on any worksheet, 
those names become available to every other worksheet in the workbook. You can also 
define worksheet-level names that are available only on the worksheet in which they are 
defined.

For more information about worksheet-level names, see “Workbook-wide vs . worksheet-only 
names” later in this chapter .

Using names in formulas

When you use the name of a cell or a range in a formula, the result is the same as using the 
cell or range address. For example, suppose you type the formula =C1+C2 in cell C3. If you 
assign the name Roger to cell C1 and the name Terry to cell C2, the formula =Roger+Terry 
has the same result and is easier to read.

The easiest way to define a name follows:

1. Select a cell.

2. Click the Name box on the left end of the formula bar, as shown in Figure 12-10.

Figure 12-10 Use the Name box on the formula bar to quickly assign names to cells and 
ranges.
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3. Type a name for the cell or range, and then press Enter. We used TestName in this 
example.

Keep the following in mind when using names in formulas:

 ● The Name box usually displays the address of the selected cell. If you named the 
selected cell or range, the name takes precedence over the address, and Excel dis-
plays it in the Name box.

 ● When you define a name for a range of cells, the range name does not appear in the 
Name box unless you select the same range.

 ● When you click the Name box and select a name, the cell selection switches to the 
named cells.

 ● If you type a name in the Name box that you already defined, Excel switches the 
selection to the named range instead of redefining the name.

 ● When you define a name, the stored definition is an absolute cell reference that 
includes the worksheet name. For example, when you define the name TestName for 
cell C3 in Sheet1, the actual name definition is recorded as Sheet1!$C$3.

For more information about absolute references, see “Understanding relative, absolute, and 
mixed references” earlier in this chapter .

Defining and managing names

Instead of coming up with new names for cells and ranges, you can simply use existing text 
labels to create names. Click the Define Name button on the Formulas tab on the ribbon to 
display the New Name dialog box shown in Figure 12-11. In this example, we selected cells 
B4:E4 before clicking the Define Name button, and Excel correctly surmised that the label 
Region_1 was the most likely name candidate for that range. If you are happy using the 
adjacent label as a name, just press Enter to define the name, or you can first add a note in 
the Comment box if you want to provide some helpful documentation.

You can, of course, define a name without first selecting a cell or range on the worksheet. 
For example, in the New Name dialog box, type Test2 in the Name text box, and then type 
=D20 in the Refers To text box. Click OK to add the name, which also closes the New Name 
dialog box. To see a list of the names you defined, click the Name Manager button on the 
Formulas tab. The Name Manager dialog box appears, as shown in Figure 12-12.
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Figure 12-11 When you click Define Name on the Formulas tab, Excel suggests any label in an 
adjacent cell in the same row or column as a name.

Figure 12-12 The Name Manager dialog box provides central control over all the names in a 
workbook.

The Name Manager dialog box lists all the names along with their values and locations. 
You’ll see that the Refers To text box shows the definition of the name we just added, 
=Sheet1!D20. Excel adds the worksheet reference for you, but note that the cell reference 
stays relative, while the Region_1 definition created by Excel uses absolute references (indi-
cated by the dollar signs in the Refers To definition). In fact, after defining the name Test2 
using a relative reference, if you click a different cell before you open the Name Manager 
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dialog box, the Refers To reference will not be the same as the one you typed because 
Excel adjusts it relative to the active cell. Also, if you do not enter an equal sign preceding 
the reference, Excel interprets the definition as text. For example, if you type D20 instead 
of =D20, the Refers To text box displays the text constant ="D20" as the definition of the 
name Test2.

When you work with tables created using the new table features in Excel, some names are 
created automatically and others are implied. If this sounds intriguing, see “Using struc-
tured references” later in this chapter.

Editing names

Although you can edit name references directly using the Refers To text box in the Name 
Manager dialog box, it is preferable to click the Edit button at the top of the dialog box. 
Doing so opens the Edit Name dialog box, which is otherwise the same as the New Name 
dialog box shown in Figure 12-11 and offers additional opportunities to change the name 
and to add a comment.

In the Edit Name dialog box, you can change cell references in the Refers To text box either 
by typing or by selecting cells on the worksheet. When you click OK in the Edit Name dia-
log box, the Name Manager dialog box reappears, displaying the updated name definition. 
Clicking the New button in the Name Manager dialog box (as you might predict) displays 
the New Name dialog box; clicking the Delete button removes all selected names from the 
list in the Name Manager dialog box. Keep in mind that when you delete a name, any for-
mula in the worksheet referring to that name returns the error value #NAME?.

Rules for naming
The following rules apply when you name cells and ranges in Excel:

 ● You must begin all names with a letter, a backslash (\), or an underscore (_) . You 
cannot use any other symbol .

 ● You can also use numbers, periods, and underscore characters .

 ● You cannot use spaces; Excel translates blank spaces in labels to underscores in 
defined names.

 ● You can’t use names that resemble cell references (for example, AB$5 or R1C7) .

 ● You can use single letters, with the exception of the letters R and C (uppercase 
and lowercase), as names .

A name can contain 255 characters . Excel does not distinguish between uppercase and 
lowercase characters in names . For example, if you create the name Tax and then create 
the name TAX in the same workbook, the second name overwrites the first.
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Workbook-wide vs . worksheet-only names

Names in Excel usually function on a workbook-wide basis. That is, a name you define on 
any worksheet is available for use in formulas on any other worksheet. But you can also cre-
ate names whose scope is limited to the worksheet—that is, names that are available only 
on the worksheet in which you define them. You might want to do this if, for example, you 
have a number of worksheets doing similar jobs in the same workbook and you want to use 
the same names to accomplish similar tasks on each worksheet. To define a worksheet-only 
name, click the Scope drop-down list in the New Name dialog box, and select the name of 
the worksheet to which you want to limit the scope of the name.

TROUBLESHOOTING
My old worksheet-level names have changed
In versions of Excel prior to 2007, you created worksheet-level names by preceding the 
name (not the cell reference) with the name of the worksheet, followed by an exclama-
tion point . This no longer works, and it’s easier now anyway, using the Scope options 
in the New Name dialog box . If you have existing worksheet-level names in workbooks 
you created using previous versions of Excel, they will still work after you import the 
workbooks into Excel 2010 or 2013, but Excel modifies the name by removing the old 
designation (the worksheet name and exclamation point) and adds the Scope designa-
tion instead .

For example, to define TestSheetName as a worksheet-only name in Sheet1, select the 
range you want, click the Define Name button on the Formulas tab, type TestSheetName 
in the Name text box, and then select Sheet1 from the Scope drop-down list, as shown in 
Figure 12-13.

Figure 12-13 Use the Scope drop-down list to specify a worksheet to which you want to restrict 
a name’s usage.
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The following are some additional facts to keep in mind when working with worksheet-only 
and workbook-level names:

 ● Worksheet-only names do not appear in the Name box on the formula bar in work-
sheets other than the one in which you define them.

 ● When you select a cell or range to which you have assigned a worksheet-only name, 
the name appears in the Name box on the formula bar, but you have no way of 
knowing its scope. You can consider adding clues for your own benefit, such as 
including the word Sheet as part of all worksheet-only names when you define them.

 ● If a worksheet contains a duplicate workbook-level and worksheet-only name, the 
worksheet-level name takes precedence over the workbook-level name on the work-
sheet where it lives, rendering the workbook-level version of the name useless on 
that worksheet.

 ● You can use a worksheet-only name in formulas on other worksheets by preceding 
the name with the name of the worksheet followed by an exclamation point. For 
example, you could type the formula =Sheet1!TestSheetName in a cell on Sheet3.

 ● You can’t change the scope of an existing name.

Creating names semiautomatically

You can click the Create From Selection button on the Formulas tab to name several adja-
cent cells or ranges at once, using row labels, column labels, or both. When you select 
this command, Excel displays the Create Names From Selection dialog box shown in 
Figure 12-14.

Figure 12-14 Use the Create Names From Selection dialog box to name several cells or ranges 
at once using labels.
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Excel assumes that labels included in the selection are the names for each range. For exam-
ple, Figure 12-14 shows that with A3:E7 selected, the Top Row and Left Column options in 
the Create Names From Selection dialog box are automatically selected, creating a set of 
names for each quarter and each region. Note that when using Create From Selection, you 
need to select the labels as well as the data. When you click the Name Manager button, 
you’ll see the names you just created listed in the dialog box.

Selecting cells while a dialog box is open
The Refers To text boxes in the New Name and Name Manager dialog boxes (and many 
other text boxes in other dialog boxes) contain a collapse dialog button, located on 
the right side of the edit box . These edit boxes, when active, allow you to navigate and 
select cells on the worksheet . Most of the time, Excel complains loudly (ding!) when 
you click outside a dialog box . For example, after you click the Refers To text box, you 
can click outside the dialog box to select any other worksheet tab, drag scroll bars, 
switch workbooks, or make another workbook active . In addition, if you click the col-
lapse dialog button, sure enough, the dialog box collapses, letting you see more of the 
worksheet, as shown here:

You can drag the collapsed dialog box around the screen using its title bar . When you 
finish, click the collapse dialog button again, and the dialog box returns to its original 
size .

Naming constants and formulas

You can create names that are defined by constants and formulas instead of by cell refer-
ences. You can use absolute and relative references, numbers, text, formulas, and functions 
as name definitions. For example, if you often use the value 8.3% to calculate sales tax, 
you can click the Define Name button, type the name Tax in the Name box, and then type 
8.3% (or .083) in the Refers To text box. Then you can use the name Tax in a formula, such 
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as =Price+(Price*Tax), to calculate the cost of items with 8.3 percent sales tax. Note that 
named constants and formulas do not appear in the Name box on the formula bar, but 
they do appear in the Name Manager dialog box.

You can also enter a formula in the Refers To text box. For example, you might define the 
name Price with a formula such as =Sheet1!A1*190%. If you define this named formula 
while cell B1 is selected, you can then type =Price in cell B1, and the defined formula takes 
care of the calculation for you. Because the reference in the named formula is relative, you 
can then type =Price in any cell in your workbook to calculate a price using the value in 
the cell directly to the left. If you type a formula in the Refers To text box that refers to 
a cell or range in a worksheet, Excel updates the formula whenever the value in the cell 
changes.

Using relative references in named formulas

When you create a named formula that contains relative references, such as 
=Sheet1!B22+1.2%, Excel interprets the position of the cells referenced in the Refers To 
text box as relative to the cell that is active when you define the name. Later, when you 
use such a name in a formula, the named formula uses whatever cell is in the same rela-
tive position. For example, if cell B21 is the active cell when you define the name Fees as 
=Sheet1!B22+1.2%, the name Fees always refers to the cell in the same column and one 
row below the cell in which the formula is currently located.

Creating three-dimensional names

You can create three-dimensional names, which use 3-D references as their definitions. For 
example, suppose you have a 13-worksheet workbook containing one identical worksheet 
for each month plus one summary sheet. You can define a 3-D name you can use to sum-
marize totals from each monthly worksheet. To do so, follow these steps:

1. Select cell B5 in Sheet1 (the summary sheet).

2. Click the Define Name button.

3. Type Three_D (or any name you choose) in the Name box, and type 
=Sheet2:Sheet13!B5 in the Refers To text box.

4. Press Enter (or click OK).

Now you can use the name Three_D in formulas that contain any of the following func-
tions: SUM, AVERAGE, AVERAGEA, COUNT, COUNTA, MIN, MINA, MAX, MAXA, PRODUCT, 
STDEV, STDEVA, STDEVP, STDEVPA, VAR, VARA, VARP, and VARPA. For example, the formula 
=MAX(Three_D) returns the largest value in the three-dimensional range named Three_D. 
Because you used relative references in step 3, the definition of the range Three_D changes 
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as you select different cells in the worksheet. For example, if you select cell C3 and display 
the Name Manager dialog box, =Sheet2:Sheet13!C3 appears in the Refers To text box.

For more information on three-dimensional references, see “Creating three-dimensional for-
mulas” later in this chapter .

Inserting names in formulas

After you define one or more names in your worksheet, you can insert those names in 
formulas by using one of several methods. First, if you know at least the first letter of the 
name you want to use, you can simply start typing to display the Formula AutoComplete 
drop-down list containing all the names beginning with that letter (along with any built-in 
functions that begin with that letter), as shown in Figure 12-15. To enter one of the names 
in your formula, double-click it.

Figure 12-15 Names you define appear in the Formula AutoComplete list when you type a 
formula.

For more information, see “Using Formula AutoComplete” earlier in this chapter .

You can also find a list of all the names relevant to the current worksheet when you click 
the Use In Formula button on the Formulas tab, which you can click while you’re in the pro-
cess of entering a formula, as shown in Figure 12-16.
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Clicking the Paste Names command at the bottom of the Use In Formula menu displays the 
Paste Name dialog box shown in Figure 12-17. If you do this in Edit mode (while you are 
editing in a cell, as in Figure 12-16), the dialog box appears as shown in Figure 12-17.

Figure 12-16 Click the Use In Formula button, and then select a name to enter it in the selected 
cell.

Figure 12-17 The Paste Name dialog box does the same job as the Use In Formula menu.

Creating a list of names

In large worksheet models, it’s easy to accumulate a long list of defined names. To keep a 
record of all the names used, you can paste a list of defined names in your worksheet by 
clicking Paste List in the Paste Name dialog box, as shown in Figure 12-18. (When you open 
the Paste Name dialog box, the Paste List button is visible only if you are in Ready mode, 
not Edit mode. You cannot be editing a cell, as shown in Figure 12-16, when you click the 
Paste Names command.) Excel pastes the list in your worksheet beginning at the active cell. 
Worksheet-only names appear in the list only when you click Paste List on the worksheet 
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where they live. Paste List is really the only useful feature in the Paste Name dialog box, 
given the superior methods of using names described in the previous section.

Figure 12-18 Click Paste List in the Paste Name dialog box to create a list of names and 
references starting at the active cell.

Note
When Excel pastes the list of names, it overwrites any existing data without asking for 
permission first. If you inadvertently overwrite data, press Ctrl+Z to undo it.

Replacing references with names

You can replace cell references with their corresponding names all at once by using the 
Apply Names command, which you access by clicking the arrow next to the Define Name 
button on the Formulas tab on the ribbon. When you do so, Excel locates all cell and range 
references for which you have defined names and replaces them with the appropriate 
name. If you select a single cell before you click the Apply Names command, Excel applies 
names throughout the active worksheet; if you select a range of cells first, Excel applies 
names to only the selected cells.

Figure 12-19 shows the Apply Names dialog box, which lists all the cell and range names 
you defined. Select each name you want to apply, and then click OK.

Excel ordinarily does not apply the column or row name if either is superfluous. For exam-
ple, Figure 12-19 shows a worksheet after we applied names using the default options in 
the Apply Names dialog box. Cell D17 contained the formula =D5. Because D17 is in the 
same column as the referenced cell, only the row name was needed, thanks to implicit 
intersection, resulting in the formula =Region_2. In the figure, cell I17 is selected, and the 
formula bar shows it contains the formula =Region_2 Qtr_3, which before names were 
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applied also contained the formula =D5. But because cell I17 isn’t in the same row or col-
umn as any of the defined ranges, applying names normally results in an error value. Apply-
ing names works well in tables where your named ranges intersect, but to apply names in 
cells outside the table, you can force row and column names to be included in formulas by 
clearing the Omit Column Name If Same Column and Omit Row Name If Same Row check 
boxes.

Figure 12-19 Use the Apply Names dialog box to substitute names for cell and range references 
in your formulas. Click Options to display all the options shown here.

The Name Order options control the order in which row and column components appear. 
For example, if we apply names using the Column Row option, the formula in cell I17 in 
Figure 12-19 becomes =Qtr_3 Region_2.

For more information about implicit intersection, see “Getting explicit about intersections” 
later in this chapter .

Select the Ignore Relative/Absolute check box to replace references with names regardless 
of the reference type. In general, leave this check box selected. Most name definitions use 
absolute references (the default when you define and create names), and most formulas 
use relative references (the default when you paste cell and range references in the formula 
bar). If you clear this check box, absolute, relative, and mixed references are replaced with 
name definitions only if the definitions use the same reference style.

Selecting the Use Row And Column Names check box is necessary if you want to apply 
names in intersection cases, as we showed in the examples. If you define names for indi-
vidual cells, however, you can clear the Use Row And Column Names check box to apply 
names to only specific cell references in formulas.
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Using Go To with names

When you click the Find & Select button on the Home tab and click Go To (or press F5), any 
names you defined appear in the Go To list, as shown in Figure 12-20. Select a name, and 
click OK to jump to the range to which the name refers. Note that names defined with con-
stants or formulas do not appear in the Go To dialog box.

Figure 12-20 Use the Go To dialog box to quickly select a cell or range by name.

Getting explicit about intersections
In the worksheet in Figure 12-19, if you type the formula =Qtr_1*4 in cell I4, Excel assumes 
you want to use only one value in the Qtr_1 range B4:B7—the one in the same row as the 
formula that contains the reference. This is called implicit intersection. Because the formula 
is in row 4, Excel uses the value in cell B4. If you type the same formula in cells I5, I6, and 
I7, each cell in that range contains the formula =Qtr_1*4, but at I5 the formula refers to cell 
B5, at I6 it refers to cell B6, and so on.

Explicit intersection refers to a specific cell with the help of the intersection operator. The 
intersection operator is the space character that appears when you press the Spacebar. If 
you type the formula =Qtr_1 Region_1 at any location on the same worksheet, the space 
between the names tells Excel that you want to refer to the value at the intersection of the 
range labeled Qtr 1 and the range labeled Region 1, which is cell B4.

Creating three-dimensional formulas
You can use references to perform calculations on cells that span a range of worksheets 
in a workbook. These are called 3-D references. Suppose you set up 12 worksheets in 
the same workbook—one for each month—with a year-to-date summary sheet on top. 
If all the monthly worksheets are laid out identically, you could use 3-D reference for-
mulas to summarize the monthly data on the summary sheet. For example, the formula 
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=SUM(Sheet2:Sheet13!B5) adds all the values in cell B5 on all the worksheets between and 
including Sheet2 and Sheet13.

You can also use 3-D names in formulas . For more information, see “Creating three- 
dimensional names” earlier in this chapter .

To construct this three-dimensional formula, follow these steps:

1. In cell B5 of Sheet1, type =SUM(.

2. Click the Sheet2 tab, and select cell B5.

3. Click the tab-scrolling button for scrolling right (located to the left of the worksheet 
tabs) until the Sheet13 tab is visible.

4. Hold down the Shift key, and click the Sheet13 tab. All the tabs from Sheet2 through 
Sheet13 turn white, indicating they are selected for inclusion in the reference you are 
constructing.

5. Type a closing parenthesis, and then press Enter.

For more information about group editing, see “Editing multiple worksheets” in Chapter 8 .

You can use the following functions with 3-D references: SUM, AVERAGE, AVERAGEA, 
COUNT, COUNTA, MIN, MINA, MAX, MAXA, PRODUCT, STDEV, STDEVA, STDEVP, STDEVPA, 
VAR, VARA, VARP, and VARPA.

Formula-bar formatting
You can enter spaces and line breaks in a formula to make it easier to read in the formula 
bar without affecting the calculation of the formula. To enter a line break, press Alt+Enter. 
Figure 12-21 shows a formula that contains line breaks. To see the complete formula in the 
formula bar, click the Expand Formula Bar button (the one with the chevron) at the right 
end of the formula bar.

Figure 12-21 You can enter line breaks in a formula to make it more readable.
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Using structured references
Creating names to define cells and ranges makes complex formulas easier to create and 
easier to read, and structured references offer similar advantages—and much more— 
whenever you create formulas in tables or formulas that refer to data in tables. Structured 
references are dynamic; formulas that use them automatically adjust to any changes you 
make to the table.

Structured references are created automatically when you create a table using the Table 
button in the Tables group on the Insert tab. Excel recognizes distinct areas of the table 
structure as separate components you can refer to by using specifiers that are either pre-
defined or derived from the table. Figure 12-22 shows a modified version of the Regional 
Sales worksheet that we converted to a table. We’ll refer to this table as we discuss struc-
tured references.

For more information about creating tables, see Chapter 22, “Managing information in 
tables .”

When you refer to data in tables by using formulas created through direct manipulation—
that is, when you click or drag to insert cell or range references in formulas—Excel creates 
structured references automatically in most cases. (If a structured reference is not applica-
ble, Excel inserts cell references instead.) Excel builds structured references using the table 
name and the column labels. (Excel automatically assigns a name to the table when you 
create one, as shown in Figure 12-22.) You can also type structured references by following 
strict syntax guidelines that we’ll explain later in this section.

Figure 12-22 We created this table to illustrate the power of structured references.
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Note
The capability to create structured references automatically is an option that is ordinar-
ily turned on . To disable this feature, click the File tab, Options, and then in the Formu-
las category clear the Use Table Names In Formulas check box .

All Excel tables contain the following areas of interest, as far as structured references are 
concerned:

 ● The table Excel automatically applies a table name when you create a table, which 
appears in the Table Name text box in the Properties group on the Table Tools Design 
tab that appears when you select a table. Excel named our table Table3 in this exam-
ple, but we changed it to Regional13 by typing in the Table Name text box, as shown 
in Figure 12-22. The table name actually refers to all the data in the table, excluding 
the header and total rows.

 ● Individual columns of data Excel uses your column headers in column specifiers, 
which refer to the data in each column, excluding the header and the total row. A 
calculated column is a column of formulas inside the table structure, such as F4:F7 in 
our example, which, again, does not include the header or total rows.

 ● Special items These are specific areas of a table, including the total row, the header 
row, and other areas specified by using special item specifiers—fixed codes that are 
used in structured references to zero in on specific cells or ranges in a table. We’ll 
explain these later in this section.

For details about calculated columns in tables, see Chapter 22 .

No more natural-language formulas
In previous versions of Excel, you could use adjacent labels instead of cell references 
when creating formulas, which was like using names without actually having to define 
them . This was called the natural-language formulas feature, but it was riddled with 
problems and was replaced a couple of versions ago with structured references, which 
work much better . When you open an older workbook containing natural-language 
formulas, an error message appears letting you know that these formulas will be con-
verted . This mandatory conversion has little effect on your worksheets other than 
changing some of the underlying formulas. Excel correctly identifies the offending 
labels and replaces them for you with the correct cell references . If you still want your 
formulas to be more readable, you can then rebuild them using names or structured 
references .
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Let’s look at an example of a structured reference formula. Figure 12-23 shows a SUM for-
mula that we created by first typing =SUM(, clicking cell B4, typing another comma, and 
finally clicking cell C4. Because the data we want to use resides within a table and our for-
mula is positioned in one of the same rows, Excel automatically uses structured references 
when we use the mouse pointer to select cells while building formulas.

Figure 12-23 We created the formula in cell H4 by clicking to select cells in the table.

The result shown in the formula bar appears to be much more complex than necessary 
because we could just type =SUM(B4:C4) to produce the same result in this worksheet. But 
the structured formula is still quite easy to create using the mouse, and it has the distinct 
advantage of being able to automatically adjust after even the most radical changes to the 
table, which ordinary formulas are not nearly as good at accommodating.

Let’s examine a little more closely the structured reference contained within the paren-
theses of the SUM function shown in Figure 12-23. The entire reference string shown 
here is equivalent to the expression (B4,C4), which combines the cells on both sides of the 
comma. The portion of the reference string in bold represents a single, complete structured 
reference:

Regional13[@[Qtr 1]],Regional13[@[Qtr 2]])

Here’s how the reference string breaks down:

 ● The first item, Regional13, is the table specifier, which is followed by an opening 
bracket. Just like parentheses in functions, brackets in structured references always 
come in pairs. The table name is a little bit like a function, in that it always includes 
a pair of brackets that enclose the rest of the reference’s components. This tells Excel 
that everything within the brackets applies to the Regional13 table.

 ● The second item, @, tells Excel that the following reference components apply only 
to those portions of the table that fall in the current row. (Obviously, this doesn’t 
work if the formula is located above or below the table.) This represents an applica-
tion of implicit intersection. (See “Getting explicit about intersections” earlier in this 
chapter.)
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 ● The third item, [Qtr 1], is a column specifier. In our example, this corresponds to the 
range B4:B7. However, because it follows the @ specifier, only cells in the range that 
happen to be in the same row as the formula are included, or cell B4 in the example.

 ● The second reference follows the second comma in the string and is essentially the 
same as the first, specifying the other end of the range, or cell C4 in the example.

Understanding structured reference syntax

Here are some of the general rules governing the creation of structured references:

 ● Table-naming rules are the same as those for defined names. See “Naming cells and 
cell ranges” earlier in this chapter.

 ● You must enclose all specifiers in matching brackets.

 ● To make structured references easier to read, you can add a single space character in 
any or all of the following locations:

 ❍ After the first opening (left) bracket (but not in subsequent opening brackets)

 ❍ Before the last closing (right) bracket (but not in subsequent closing brackets)

 ❍ After a comma

 ● Column headers are always treated as text strings in structured references, even if the 
column header is a number.

 ● You cannot use formulas in brackets.

 ● You need to use double brackets in column header specifiers that contain one of the 
following special characters: tab, line feed, carriage return, comma, colon, period, 
opening bracket, closing bracket, pound sign, single quotation mark, double quota-
tion mark, left brace, right brace, dollar sign, caret, ampersand, asterisk, plus sign, 
equal sign, minus sign, greater-than symbol, less-than symbol, and division sign—for 
example, Sales[[$Canadian]]. Space characters are permitted.

Using operators with column specifiers

You can use three reference operators with column specifiers in structured references—a 
colon (:), which is the range operator; a comma (,), which is the union operator; and a space 
character ( ), which is the intersection operator.

For example, the following formula calculates the average combined sales for quarters 1 
and 4 using a comma (the union operator) between the two structured references:

=AVERAGE(Regional13[Qtr 1],Regional13[Qtr 4])
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The following formula calculates the average sales for quarters 2 and 3 by using colons (the 
range operator) to specify contiguous ranges of cells in each of the two structured refer-
ences within the parentheses and by using a space character (the intersection operator) 
between the two structured references, which combines only the cells that overlap (Qtr 2 
and Qtr 3):

=AVERAGE(Regional13[[Qtr 1]:[Qtr 3]] Regional13[[Qtr 2]:[Qtr 4]])

About the special item specifiers

Excel provides five special codes you can use with your structured references that refer 
to specific parts of a table. You already saw the special item specifier @ used in previous 
examples. Here are all five special item specifiers:

 ● @ This specifier identifies cells at the intersection created in conjunction with col-
umn specifiers; you cannot use it with any of the other special item specifiers in this 
list.

 ● [#Totals] This refers to cells in the total row (if one exists) and returns a null value if 
there is no total row.

 ● [#Headers] This refers only to cells in the header row.

 ● [#Data] This refers only to cells in the data area between the header row and the 
total row.

 ● [#All] This refers to the entire table, including the header row and the total row.

Are your references qualified?
Two kinds of structured references exist: qualified and unqualified . Generally, you can 
use unqualified references in formulas you construct within a table because the formu-
las are insulated from errors that could be introduced by inserting, deleting, or mov-
ing cells by virtue of the robust infrastructure of the table . When you build formulas 
outside the protective structure of a table, it is advisable to use qualified references to 
protect against such errors. Here is an example of an unqualified reference that works 
only within a table, followed by a qualified reference that produces the same result 
outside the table:

=[Qtr 1]/[Total]

=Regional13[@[Qtr 1]]/Regional13[@Total]]
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Using Formula AutoComplete with structured references

As you enter your formulas, the Formula AutoComplete feature is there to help you along 
by displaying lists of applicable functions, defined names, and structured reference speci-
fiers as you type. For example, Figure 12-24 shows a formula being constructed using a 
SUM function, along with an AutoComplete drop-down list displaying all defined items that 
begin with the opening bracket character (also called a display trigger in AutoComplete 
parlance) that you just typed in the formula. Notice that the list includes all the column 
specifiers for the table, as well as all the special item specifiers, all of which begin with a 
bracket.

Figure 12-24 Structured reference specifiers appear in the AutoComplete drop-down list if they 
are applicable for a formula.

To enter one of the items in the list in the formula, double-click it. The Formula Auto-
Complete list will most likely open more than once as you type formulas, offering any and 
all options that begin with the entered letters or display triggers. For example, the Auto-
Complete list appeared after we typed =S with a list of all the items beginning with that 
letter and again after typing the R in Regional13.

For more information, see “Using Formula AutoComplete” earlier in this chapter .

Filling and copying structured references

As a rule, structured references do not adjust like relative cell references when you copy or 
fill them—the reference remains the same. The exceptions to this rule occur with column 
specifiers when you use the fill handle to copy fully qualified structured references outside 
the table structure. For example, in the worksheet shown in Figure 12-25, we dragged the 
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fill handle to copy the % of Total formula in cell K4 to the right, and the column specifiers 
in the formulas adjusted accordingly.

Figure 12-25 You can drag the fill handle to extend structured reference formulas into adjacent 
cells, but they behave a little bit differently from regular formulas.

The results illustrate some interesting structured-reference behavior. Notice that the first 
formula shown in cell K4 divides the value in the Qtr 1 column by the value in the Total 
 column. After we filled to the right, the resulting formula in cell N4 divides the value in the 
Qtr 4 column by the value in the Qtr 2 column. How did this happen?

As far as filling cells is concerned, tables act like little traps—you can check in, but you can’t 
check out. The formula shown at the top in Figure 12-25 has two column specifiers: Qtr 1 
and Total. When we filled to the right, the Qtr 1 reference extended the way we wanted—
to Qtr 2, Qtr 3, and Qtr 4 in each cell to the right. However, the Total reference, instead of 
extending to the right (G4, H4, I4) like a regular series fill would, “wrapped” around the 
table (2013, Qtr 1 and Qtr 2), resulting in the formula displayed in cell N4 at the bottom of 
Figure 12-25. This is interesting behavior, and we’re sure people will figure out ways to put 
it to good use.

For more information about using the fill handle, see “Filling cells and creating data series” in 
Chapter 8 .

What we need is a way to “lock” the Total column reference, but Excel doesn’t offer any way 
to create “absolute” column specifiers, as it does with cell references. We can, however, sub-
stitute a cell reference for the entire Total reference, as shown in Figure 12-26. We used a 
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mixed reference in this case, specifying the absolute column $F but letting the row number 
adjust so that we could fill down as well.

Figure 12-26 We replaced the second structured reference with a mixed cell reference to make 
filling these formulas work properly.

Note that if we were to select cell H4 in Figure 12-26 and drag the fill handle down, the 
formulas in each cell would not appear to adjust at all, yet they would work perfectly. (The 
formula in cell H4 appears in Figure 12-23.) This is because explicit intersection, the built-in 
behavior of column specifiers, and the functionality of the @ specifier eliminate the need to 
adjust row references.

Note
When you drag the fill handle to the right in a cell containing a structured-reference 
formula, pressing Ctrl prevents the column specifiers from adjusting as they usually 
would and instead copies the formula to the right without adjustment .

Worksheet calculation
When you change the value in any of the cells to which a formula refers, Excel updates the 
displayed values of the formula as well. This updating process is called recalculation, and it 
affects only cells containing references to cells that have changed. By default, Excel recalcu-
lates whenever you make changes to a cell. If a large number of cells must be recalculated, 
the word Calculating appears in the status bar, along with a percentage-of-progress meter 
if the process is going to take a particularly long time. You can interrupt the recalculation 
process simply by doing something, such as using commands or making cell entries; Excel 
pauses and then resumes the recalculation when you finish.
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INSIDE OUT   Legacy recalc

When you open an Excel 2010 or 2013 workbook, Excel recalculates only formulas that 
depend on cell values that have changed . However, because of changes in the way Excel 
2010/2013 recalculates, when you open a workbook that was saved in an earlier Excel 
file format, Excel recalculates all the formulas in the workbook each time you open it. 
To avoid this, save the workbook in the Excel Workbook (.xlsx or .xlsm) file format.

Recalculating manually
There are various reasons why you might want to prevent Excel from recalculating each 
time you enter data in a cell, but computer speed, which used to be one of the top reasons, 
really isn’t much of an issue anymore (unless your computer is very old). Nevertheless, you 
can switch from automatic to manual recalculation, and Excel will recalculate only when 
you tell it to. To set manual recalculation, click the Calculation Options button on the For-
mulas tab on the ribbon and then choose the Manual option. You can also click the File tab, 
Options, and then select the Formulas category to display the additional options shown in 
Figure 12-27.

Here are a few facts to remember about calculation options:

 ● With worksheet recalculation set to Manual, the status bar displays the word Calcu-
late if you make a change; click it to initiate recalculation immediately.

 ● The Recalculate Workbook Before Saving check box helps make sure the most cur-
rent values are stored on disk.

 ● To turn off automatic recalculation only for data tables, select the Automatic Except 
For Data Tables option. For more information, see “Using data tables” in Chapter 18, 
“Performing a what-if analysis.”

 ● To recalculate all open workbooks, click the Calculate Now button in the Calculation 
group on the Formulas tab, or press F9.

 ● To calculate only the active worksheet in a workbook, click the Calculate Sheet button 
in the Calculation group on the Formulas tab, or press Shift+F9.
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Figure 12-27 The Formulas category in the Excel Options dialog box controls worksheet 
calculation and iteration.

Multithreaded calculation
If you have a computer with a multicore processor, perhaps with additional hyper-
threading, Excel takes full advantage of the additional power by dividing the workload 
among available processors . Click the File tab, Options, Advanced category, and look in 
the Formulas area . Excel automatically detects additional processors and displays the 
total number adjacent to the Use All Processors On This Computer option . The number 
of processors also appears in the status bar next to the word Calculating, if you have 
enough formulas to slow the calculation process sufficiently for it to appear. You can 
turn this option off to reserve some of your computer’s processing bandwidth for other 
programs you need to run simultaneously .

Calculating part of a formula
You might want to see the result of just one part of a complex formula if, for example, you 
are tracking down a discrepancy. To change only part of a formula to a value, select the 
part you want to change and press F9. You also can use this technique to change selected 
cell references in formulas to their values. Figure 12-28 shows an example.
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If you’re just verifying your figures, press the Esc key to discard the edited formula. Other-
wise, if you press Enter, you replace the selected portion of the formula.

Figure 12-28 Select any part of a formula, and press F9 to convert it to its resulting value.

Note
You also can click the Evaluate Formula button on the Formulas tab to troubleshoot 
your workbook models . For more information, see “Evaluating and auditing formulas” 
in Chapter 8 .

Working with circular references
A circular reference is a formula that depends on its own value. The most obvious type is a 
formula that contains a reference to the same cell in which it’s entered. For example, if you 
type =C1-A1 in cell A1, Excel displays the error message shown in Figure 12-29. After you 
click OK, Excel opens the Help dialog box, which displays a pertinent topic.

Figure 12-29 This error message appears when you attempt to enter a formula that contains a 
circular reference.
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If a circular-reference warning surprises you, this usually means you made an error in a 
formula. If the error isn’t obvious, verify the cells that the formula refers to by using the 
built-in, formula-auditing features. For details, see “Auditing and documenting worksheets” 
in Chapter 8.

When a circular reference is present in the current worksheet, the status bar displays the 
text Circular References followed by the cell address, indicating the location of the circular 
reference on the current worksheet. If Circular References appears without a cell address, 
the circular reference is located on another worksheet.

As you can see in Figure 12-30, when you click the arrow next to the Error Checking button 
on the Formulas tab and click Circular References, any circular references that exist on the 
current worksheet are listed on a menu (which appears only if a circular reference is pres-
ent). Click the reference listed on this menu to activate the offending cell.

Figure 12-30 The Circular References menu appears if any circular references are present.

You can resolve many circular references. Some circular formulas are useful or even essen-
tial, such as the set of circular references shown in Figure 12-31. These formulas are circular 
because the formula in cell N30 depends on the value in N31, and the formula in N31 
depends on the value in N30.

Figure 12-31 illustrates a circular reference scenario called convergence: the difference 
between results decreases with each iterative calculation. In the opposite process, called 
divergence, the difference between results increases with each calculation.
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Figure 12-31 The discount formula in cell N30 is circular because it depends on the total, which 
in turn depends on the discount value in N30.

When Excel detects a circular reference, tracer arrows appear on the worksheet. To draw 
additional arrows to track down the source of an unintentional circular reference, select the 
offending cell and then click Trace Precedents on the Formulas tab to draw tracer arrows to 
the next level of precedent cells, as shown in Figure 12-31.

For more information about tracer arrows and other auditing features, see “Auditing and 
documenting worksheets” in Chapter 8 .

You’ll find the Circular Reference.xlsx file with the other examples on the companion 
website.

After you dismiss the error message shown earlier in Figure 12-29, the formula will not 
resolve until you allow Excel to recalculate in controlled steps. To do so, click the File tab, 
Options, Formulas category, and in the Calculation Options section, select the Enable Itera-
tive Calculation check box. Excel recalculates all the cells in any open worksheets that con-
tain a circular reference.

If necessary, the recalculation repeats the number of times specified in the Maximum 
Iterations box (100 is the default). Each time Excel recalculates the formulas, the results in 
the cells get closer to the correct values. If necessary, Excel continues until the difference 
between iterations is less than the number typed in the Maximum Change text box (0.001 
is the default). Thus, using the default settings, Excel recalculates either a maximum of 100 
times or until the values change less than 0.001 between iterations, whichever comes first.

If the word Calculate appears in the status bar after the iterations are finished, more itera-
tions are possible. You can accept the current result, increase the number of iterations, or 
lower the Maximum Change threshold. Excel does not repeat the “Cannot Resolve Circular 
Reference” error message if it fails to resolve the reference. You must determine when the 
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answer is close enough. Excel can perform iterations in seconds, but in complex circular 
situations, you might want to set the Calculation option to Manual; otherwise, Excel recal-
culates the circular references every time you make a cell entry.

The Solver add-in, a “what-if” analysis tool, offers more control and precision when working 
with complex iterative calculations . For details, see “Using the Solver” in Chapter 18 .

Understanding the precision of numeric values
Here are three interesting facts about numeric precision in Excel:

 ● Excel stores numbers with as much as 15-digit accuracy and converts any digits after 
the fifteenth to zeros.

 ● Excel drops any digits after the fifteenth in a decimal fraction.

 ● Excel uses scientific notation to display numbers that are too long for their cells.

TROUBLESHOOTING
Rounded values in my worksheet don’t add up
Your worksheet can appear erroneous if you use rounded values . For example, if you 
use cell formatting to display numbers in currency format with two decimal places, 
Excel displays the value 10.006 as the rounded value $10 .01 . If you add 10 .006 and 
10 .006, the correct result is 20 .012 . If all these numbers are formatted as currency, how-
ever, the worksheet displays the rounded values $10.01 and $10.01, and the rounded 
value of the result is $20.01 . The result is correct, as far as rounding goes, but its 
appearance might be unacceptable for a particular purpose, such as a presentation or 
an audit .

You can correct this problem by changing the currency format, or you can click the 
File tab, Options, Advanced category . In the When Calculating This Workbook area, 
select the Set Precision As Displayed check box . However, you should select this check 
box only with extreme caution because it permanently changes the underlying values 
in your worksheet to their displayed values . For example, if a cell containing the value 
10.006 is formatted as currency, selecting the Set Precision As Displayed check box per-
manently changes the value to 10.01 . For more information, see “Formatting numbers” 
in Chapter 9 .
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Table 12-3 contains examples of how Excel treats integers and decimal fractions longer than 
15 digits when they are typed in cells with the default column width of 8.43 characters.

TABLE 12-3 Examples of numeric precision

Typed entry Displayed value Stored value

123456789012345678 1.23457E+17 123456789012345000
1.23456789012345678 1.234568 1.23456789012345
1234567890.12345678 1234567890 1234567890.12345
123456789012345.678 1.23457E+14 123456789012345

Excel can calculate positive values as large as 9.99E+307 and approximately as small as 
1.00E–307. If a formula results in a value outside this range, Excel stores the number as text 
and assigns a #NUM! error value to the formula cell.

Using arrays
Arrays are familiar concepts to computer programmers. Simply defined, an array is a collec-
tion of items. Excel is one of the few applications that facilitate array operations, in which 
items that are part of an array can be individually or collectively addressed in simple math-
ematical terms. Here is some basic array terminology you should know:

 ● An array formula acts on two or more sets of values, called array arguments, to return 
either a single result or multiple results.

 ● An array range is a block of cells that share a common array formula.

 ● An array constant is a specially organized list of constant values you can use as argu-
ments in array formulas.

Arrays perform calculations in a way unlike anything else. You can use them for worksheet 
security, alarm monitors, linear regression tables, and much more.

One-dimensional arrays
The easiest way to learn about arrays is to look at a few examples. For instance, you can cal-
culate the averages shown in Figure 12-32 by entering a single array formula.




